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Introduction

Security and surveillance technology 

for museums, exhibitions, private collections and luxury goods trade

Thank you for choosing the Human Detector Flex alarm system.

A powerful, compact and quick-to-install security and surveillance system, it supports you in protecting your

exhibits and valuables. Whether paintings, sculptures or automobiles, the Human Detector Flex system

features a wide range of applications. 

Sensors and alarm modules are available for almost every task. These are extremely small and can be

operated with inexpensive lithium batteries, which last for up to 10 years. 

(HDF - Human Detector Flex)

HDF-3D PROTECT The HDF-3D PROTECT module detects the slightest vibrations

(structure-borne sound) and movements. This provides for the effective

protection of showcases, pedestals, technical exhibits and vehicles.

HDF-TOUCH Approaching and touching objects can be easily detected with the HDF-

TOUCH module. The system is ideal for securing metallic objects, but

can also be used for other purposes.

HDF-HANG HDF-HANG secures pictures and hanging objects on gallery rails.

HDF-OPTICAL Pictures, paintings and other hanging objects can be secured

sustainably, simply and contact-free with HDF-OPTICAL.

HDF-EXTERN External sensors with an alarm output (NO or NC) can be connected

directly to the HDF-EXTERN module. This allows the Human Detector

Flex System to be extended as required.

HDF-WIRE Securing with tear-off wires is in many cases the cheapest and quickest

way to secure "small items" against theft. The HDF-WIRE module

supports up to two signalling circuits.

HDF-DOOR HDF-DOOR secures doors, flaps and inspection hatches. 

HDF-SHOCK The HDF-SHOCK module detects heavy blows, position changes and

vibrations.

HDF-REMOTE The HDF-REMOTE panic button allows for alarm messages to be easily

and invisibly sent by supervisors. 

All alarm modules, with the exception of the  HDF-REMOTE panic button, can additionally be operated with an

external power supply unit. The connection to the alarm centres (HDF-BUZZER and HDF-SPEECH) and the

HDF-AMD alarm management system is wireless via radio. The communication that takes place in the 868

MHz range uses a special modulation method that easily penetrates solid walls and large buildings. The

ranges achieved here are often several times greater than those that can be achieved with conventional

systems.
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The HDF-BUZZER and HDF-SPEECH alarm centres

Two systems with different extension levels are available with the HDF-BUZZER and HDF-SPEECH alarm

centres.

The basic system HDF-BUZZER enables the output of a loud alarm via a built-in piezo siren (buzzer). In

addition, three potential-free relay outputs are available. These can be individually controlled by the alarm

modules. Alarm messages are acknowledged, and the system is armed and disarmed via an external input

using a key switch. 

The HDF-SPEECH alarm centre also has a voice output. Voice and sound messages are stored as .mps3

files and used as alarm messages.

The HDF-AMD unit (AMD = Alarm Management Device) enables targeted forwarding of alarm messages to

IP-based control centers according to SIA-DC09 standard and Ademco CID encoding. A precise distinction is

made here as to who is responsible for which alarm. Likewise, the HDF-AMD in combination with the HDF-

ANTIJAM monitors the radio network for interfering signals. The HDF-AMD is an open system. Future

projects - such as the transmission of measurement data (temperature, humidity, etc.), but also the

connection to video control centres - can be implemented. 
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HDF-CONFIGURATOR Software

General

The HDF-CONFIGURATOR manual describes the functionality of the Windows configuration software for the

backup technology of the Human Detector Flex family.

The software enables the programming of the HDF-BUZZER and HDF-SPEECH alarm centres via USB

interface. The HDF-AMD alarm management system can also be set using a wireless network. 

In addition, the HDF-CONFIGURATOR software enables the security engineer to create optimised

installations and adapt these to their security requirements. The software supports the creation of

documentation and saves log and configuration files.

Basic agreements for the operating instructions:

HDF sensors

The term HDF sensors refers to Human Detector Flex sensors. In the operating instructions the terms

sensors, alarm modules, alarm sensors, sensor modules, detectors and the individual product names (such

as HDF-DOOR, HDF-EXTERN, etc.) are used. In all cases, the sensors are HDF sensors.

HDF alarm centres

The term HDF alarm centres refers to Human Detector Flex alarm centres. In the operating instructions the

terms alarm centres, radio control centres, alarm units and the individual product names (HDF-BUZZER and

HDF-SPEECH) are used. In all cases, these are HDF alarm centres.

HDF alarm management device

The term HDF alarm management device refers to Human Detector Flex alarm management device. In the

operating instructions the terms alarm management device, HDF alarm management system, alarm

management system and the individual product names (HDF-AMD) are used. In all cases, it is an HDF alarm

management device. The abbreviation AMD refers to Alarm Management Device.

Designation of screen panels

The screen of the HDF-CONFIGURATOR software is used to control your security installation. The

manufacturer, heddier electronic GmbH, has placed great emphasis on ensuring that all relevant

information is always in the user's field of vision. The operating steps involve only a few repetitive actions. 

These are easily recognisable and enable a quick familiarisation with the HDF-CONFIGURATOR software.

We would like to explain the main areas of the screen in advance, in order to facilitate these operating

instructions.
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Main menu

The main menu with a red background contains the most frequently used functions for controlling the

software.

Additional menu

The additional menu with a green background allows direct access to frequently used functions. The

additional menu can display different contents depending on the operating modes.

Configuration area

The overall configuration of the project is displayed in the configuration area with a yellow background. An

integrated zoom function facilitates the display of large projects.

Functional area

Entries and settings are made in the turquoise/blue highlighted function area. This is the main working area

of the HDF-CONFIGURATOR software.

Overview sensors

The column with a red background shows the project HDF sensors.

Overview alarm units

The line with a green background shows the project HDF alarm units (alarm centres and alarm management

devices).

Linking area

The linking area with a yellow background shows the assignment of HDF sensors to HDF alarm units.

Action window

Situation-related entries are made and actions are started in the action window with a turquoise/blue

background. The action window is only visible during the respective action.

The Human Detector Flex systems can be used in three different operating modes. With the exception of

operation in EASY-Mode, the use of the HDF-CONFIGURATOR software is mandatory for the other two

operating modes. 

EASY-Mode

EASY-Mode is the most simple operating mode. It is intended for small security system installations. In

EASY-Mode up to 30 alarm sensors can in principle be connected to one or more alarm centres (HDF-

BUZZER or HDF-SPEECH). The connection only requires a simple pairing at the push of a button on the

respective sensor. All alarm sensors on an alarm centre have the same alarm behaviour. An individual alarm

form is not possible for individual alarm sensors. Alarm sensors that have already been created cannot be

deleted individually.
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The HDF-CONFIGURATOR software in EASY-Mode is only required for changing the alarm behaviour of the

respective HDF-BUZZER or HDF-SPEECH unit. This change is then valid for all paired alarm sensors.

MULTI-Mode

The use of the HDF-CONFIGURATOR software is mandatory in MULTI-Mode. The complete installation of

the security system is initially planned with the software. After completion of the planning, the user can enter

the hardware identifiers (ID codes) of the individual Human Detector Flex components. The project data

generated in this way can now be transferred to the various alarm centres (HDF-BUZZER or HDF-SPEECH)

with the HDF-CONFIGURATOR software via USB cable.

The MULTI-Mode provides the user with a high degree of flexibility. Each sensor and each alarm centre can

be individually programmed. The maximum number of alarm sensors per alarm centre is 200. The HDF-

CONFIGURATOR software also generates up-to-date project documentation.

PROFI-Mode

The use of the HDF-CONFIGURATOR software is also mandatory in PROFI-Mode. The PROFI-Mode is a

powerful extension of the MULTI-Mode. An HDF-AMD alarm management system is installed in addition. This

unit controls and evaluates all alarm and system messages. The information obtained in this way is forwarded

specifically to a local or external control center. The settings required for commissioning are made with the

HDF-CONFIGURATOR software. The functions of the MULTI-Mode installation are completely retained in

PROFI-Mode. Updating from EASY to MULTI-Mode or from MULTI to PROFI-Mode is possible at any time.

Moving in the opposite direction is feasible, but will always lead to restrictions in functionality.

Note:
You can download the latest version of the HDF-CONFIGURATOR software from the manufacturer's

download server. More information and access data will be provided after the purchase of the corresponding

components.

Safety instructions

Important safety instructions!
The HDF-CONFIGURATOR manual should be studied before commencing with the programming/set-up. The

installation of the Human Detector Flex Systems in conjunction with the HDF-CONFIGURATOR software

(MULTI and PROFI-Mode) should only be carried out by a trained and experienced technician. 

Projects should be saved regularly.

Handle the stored projects carefully and protect them from unauthorized access.

Check all settings after programming has been carried out. Test the programmed units for this.

Possible errors can then immediately be detected. 

The following system requirements are necessary to ensure error-free operation:

·PC with Windows 10 operating system or higher

·USB interface

·WIFI adapter (2.4 GHz)
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General terms of use

The use of the software is subject to the "General Terms of Use". These are agreed to with the installation of

the HDF-CONFIGURATOR software.

General Terms of Use for the Configuration Software Human Detector Flex - Configurator (HDF-

CONFIGURATOR) of heddier electronic GmbH

Last updated: 01 January 2022

1 Scope

1.1 These General Terms of Use regulate the use of the configuration software HDF-CONFIGURATOR

(hereinafter referred to as "software") between the user (hereinafter referred to as "client") and heddier

electronic Gesellschaft für innovative Datensysteme mbH (hereinafter referred to as "heddier").

The software enables the setting and configuration of various alarm devices from the Human Detector Flex

range. The application profiles created in this way are transferred to the respective devices via USB cable or

WLAN. Application profiles can be saved and used for documentation.

1.2 The software is described and advertised on the website www.human-detector.com for museums, cultural

institutions, galleries, institutional collectors and comparable persons and enterprises. The software is used

exclusively by the institutions and persons named here in accordance with the following General Terms of

Use. The users of the software are usually technicians employed by these institutions. The General Terms of

Use can be saved and/or printed out.

1.3 Usage is only offered to entrepreneurs, tradesmen, freelancers and public institutions. Consumers in the

sense of §13 BGB (German Civil Code) are not offered usage.

2 Prerequisites for use

2.1 The software can be downloaded free of charge from the www.human-detector.com website. The client

needs to complete an online registration before downloading. The data provided in the registration will be

checked by heddier. The client will be sent a confirmation email with a download link valid for a limited period

of time.

2.2 heddier has the right not to accept individual registrations and to refuse the confirmation email. This is

particularly the case if the data sent with the registration gives rise to the suspicion that the user is not a user

pursuant to 1.2.

2.3 The client has the right to install the software on several end devices (personal computers with the

Microsoft Windows operating system).

2.4 The client confirms the General Terms of Use during the installation of the software. The installation

without confirmation and the associated acceptance of the General Terms of Use is not possible.

3 Prices 

3.1 Usage of the software is free of charge. 

3.2 heddier reserves the right to raise prices for future additional software modules. It is not necessary to

purchase the additional modules to use the software.

4 Liability

4.1 heddier will only pay damages or compensation for futile expenses, regardless of the legal reason (e.g.

breach of duty, tort), to the following extent: 

a) in the case of intent, in the full amount; 
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b) in the event of gross negligence, in the amount of the typical and foreseeable damage that should have

been prevented through duty of care; 

c) in other cases, only in the event of a breach of a material contractual obligation and in the event of default,

to compensation for typical and foreseeable damage, limited to the costs of the Human Detector Flex

hardware directly affected by the installation.

4.2 The statutory liability for personal injury and under the Product Liability Act shall remain unaffected. 

4.3 In case of data loss, heddier is only liable for damages that would have occurred even if the client had

properly backed up the data (see 5.3).

4.4 heddier assumes no liability for the proper functioning of the software on all end devices available on the

market.

5 Client obligations

5.1 The client shall take reasonable precautions in the event that the software does not work properly in

whole or in part. For this purpose, heddier offers the possibility to operate the Human Detector Flex alarm

systems in EASY-Mode. The use of the software is not necessary in this operating mode with a reduced

range of functions.

5.2 The client shall thoroughly test the software for its usability for its intended purpose before using it in an

operational manner. In addition, clients will familiarize themselves in the usage of the software.

5.3 The client shall back up data in accordance with state-of-the-art technology and procedures. This

ensures that the current data from data files held in machine-readable form can be reproduced with

reasonable effort. 

5.4 The client shall take appropriate measures to protect software and data backups from unauthorised

access.

5.5 The client is obliged to immediately report any occurring software error to heddier.

6 Warranty

6.1 heddier guarantees from the time of handover that the software essentially corresponds to the

description in the manual with regard to its functionality and is executable with the above-mentioned end

devices on the above-mentioned operating system. A temporal guarantee is not specified, as updated and/or

extended versions of the software may be published at a later date. 

6.2 heddier is at liberty to remedy the defect reported by the client within a reasonable period of time by

means of a maximum of three replacement deliveries or subsequent rectifications. If heddier does not

succeed in doing so, the client shall be entitled to demand a reduction. 

6.3 heddier does not guarantee that the software meets the client's needs, functions with the client's

programmes or that the software is suitable for the client's purposes.

7 Support 

7.1 Telephone or email support in respect of the software as per contract is included in the subscription fees

to the usual extent. 

7.2 Not included in the support are training in operation and installation of the software and services for the

end devices used by the client. All fee-based support services are charged by heddier in consultation with

the client at the current hourly rate in 10 minute intervals.
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8 Applicable law and place of jurisdiction

8.1 The law of the Federal Republic of Germany shall apply to the exclusion of the UN Convention on

Contracts for the International Sale of Goods.

8.2 If the client is a merchant, a legal entity under public law or a trust under public law, the place of

jurisdiction shall be Coesfeld.

9 Other

9.1 All supplements and amendments to these General Terms and Conditions of Use must be in writing to be

effective. The contracting parties shall also satisfy this requirement by sending documents in text form, in

particular by fax or email, unless otherwise provided for individual declarations in this contract. 

9.2 Additional agreements, supplements and amendments to the General Terms and Conditions of Use

between heddier and the client require the written consent of heddier's executive board to become effective.

This is especially true for the assumption of additional guarantees.

9.3 Should it transpire that provisions of the General Terms of Use are invalid or void, this shall not affect the

contract as a whole. Rather, the invalid or void provision shall be replaced by a valid provision that comes as

close as possible to the meaning of the General Terms of Use.
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Installation

To install the English version of the HDF-CONFIGURATOR software, you need the installation file HDF-

CONFIGURATOR-en.msi. These can be obtained from heddier electronic GmbH on request.

Important note:
Please check installation files carefully you may find in forums or on internet platforms. heddier electronic

GmbH cannot assume any responsibility and will not provide support for programmes from non-official

sources.

Start the installation software by running the HDF-CONFIGURATOR-en.msi file.

Confirm the action window by pressing [Next].

Please read the "General Terms of Use" carefully and agree to them if you wish to use the HDF-

CONFIGURATOR software. If you wish, you can also print out the terms of use. 

Click [Next] to change to the next window.

If necessary, you can change the installation location of the software here. The installation location must be

on your personal computer and not on an outsourced network partition. 
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After entering all the required information, you can start installing the programme files by pressing [Install].

After all files have been set up, you can finish the installation by pressing [Finish]. The HDF-

CONFIGURATOR software can now be started from the Windows start menu.

Repair and removal of the HDF-CONFIGURATOR software

Start the HDF-CONFIGURATOR-en.msi file again. The installation software recognises the original

installation and provides the following options:

You can repair or completely remove a possibly damaged installation here.

Note:
The repair only applies to programme files. Projects you have created cannot be edited with this function. If

you store your project files under the installation directory, they will also be deleted when you "remove"

these.

Updating the HDF-CONFIGURATOR software

Start the installation software first, if you wish to carry out an update. If the software version is newer, the

update will automatically be carried out. If the installation software corresponds to an older version, this will be

indicated by an error message and the installation process will be aborted. 
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Starting HDF-CONFIGURATOR

After starting the HDF-CONFIGURATOR software, the following screen appears:

You can choose one of the following three options in the action window:

New Project

Creates a new Human Detector Flex project.

Open Project

Opens an existing Human Detector Flex project.

Close

Closes the central selection window and provides access to menus and functions of the HDF-

CONFIGURATOR software that can be used at this time.

Note:
If you want to exit the HDF-CONFIGURATOR software, you first need to close the central action window.
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HDF-CONFIGURATOR menus

The HDF-CONFIGURATOR software offers four function blocks in the main menu. These are grouped

together in the usual way in a menu bar at the top of the screen. 

File menu

The File menu contains the following functions.

New Project

Creates a new Human Detector Flex project. This function corresponds to the action window at the start of

the programme.

Open Project

Opens an existing Human Detector Flex project. This function corresponds to the selection menu at the

start of the programme.

Save

Saves the current project under the previously selected project name. There will be no additional prompt.

Save as

Saves the current project under a project name, which can be defined in a selectable directory.

Change Project Password

If a password already exists for the project, it can be changed here. If the project has been saved without a

password so far, a password can be assigned to the project here. 

Notes:
The password consists of at least 6 characters. Please choose a "strong" password, e.g. consisting of a

random combination of numbers and letters.

The selected password is the project password. It is used to store and protect the project. It is not to be

confused with the passwords of the alarm centres (HDF-BUZZER and HDF-SPEECH) and the password of

the alarm management system (HDF-AMD).

Save the password in a secure location. If the password is lost, the project can no longer be opened

and edited.

Settings

Enables the selection of the language for the guidance of the user of the HDF-CONFIGURATOR software.

Print

Prints the complete documentation of a Human Detector Flex project. The print output can be set within the

scope of the Windows options. 
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Close

Exits the HDF-CONFIGURATOR software. If the project has not been saved, a confirmation prompt will be

displayed.

Edit menu

The Edit menu contains the following functions.

Add HDF-Sensor

Enables the addition of new Human Detector Flex sensors.

Add HDF-BUZZER

Enables the addition of a new HDF-BUZZER alarm centre.

Add HDF-SPEECH

Enables the addition of a new HDF-SPEECH alarm centre.

Add HDF-AMD

Enables the addition of a new HDF-AMD alarm management device.

Programming HDF-BUZZER/SPEECH

Enables the transfer of project data to an HDF-BUZZER or HDF-SPEECH unit.

Change HDF-BUZZER/SPEECH Password

Enables changing the password of an HDF-BUZZER or HDF-SPEECH unit.

Read HDF-BUZZER/SPEECH Configuration

Enables reading the project data of an HDF-BUZZER or HDF-SPEECH unit.

Programming HDF-AMD

Enables the transfer of project data to an HDF-AMD unit.

Change HDF-AMD Password

Enables changing the password of an HDF-AMD unit.

Read HDF-AMD Configuration

Enables reading the project data of an HDF-AMD unit.

Download HDF-AMD Log Files

Enables downloading the log files of an HDF-AMD unit.
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Designer menu

The Designer menu is deactivated in the current HDF-CONFIGURATOR software. HDF-DESIGNER is a

future software module to support the graphical design work of building services planners and architects.

Help menu

The Help menu contains the following functions.

Version

Displays the current version number of the HDF-CONFIGURATOR software.

Imprint

Displays information about the HDF-CONFIGURATOR software manufacturer.

In addition to the described menu bar in the upper area of the screen, the software contains additional

operating elements in the lower area.

Zoom slider

The [Zoom] slider allows you to zoom in and out of the project display in the configuration area. This enables

the convenient display of large projects. As soon as the display is enlarged, a horizontal or vertical scroll bar

is automatically displayed - depending on the orientation.

Depending on the selected project mode, a maximum of three additional menu items are displayed in the

lower corner of the screen (additional menu).

Project Summary

After selecting this function, the "General Information" of the project can be edited and displayed.

This menu item is visible in all operating modes (PROFI, MULTI and EASY-Mode).

Alarm Area

This function maps the room layout of the building in which the objects to be secured are located. The rooms

can be named individually. A hierarchical structure in the form of a tree structure is available. This function is

required to simplify the classification of alarms. This menu item is only visible in PROFI-Mode.

Programming

Enables the transfer of project data to an HDF-BUZZER, HDF-SPEECH or HDF-AMD unit. This menu item is

visible in all operating modes (PROFI, MULTI and EASY-Mode).
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Settings

In the Settings menu the language of the HDF-CONFIGURATOR software can be set. Additional languages

can be added to the software. Please contact our technical sales department for more information about

language extension. Changing the set language will become effective after restarting the software.

Manage HDF projects

All important settings for securing exhibits with the Human Detector Flex technology are stored in ‘projects’.

The associated files are stored on your computer with the file extension *.hdfproj. This extension is unique

and should only be used by the Human Detector Flex systems.

Several functions are available for the administration and maintenance of HDF projects.

Creating a new HDF project

Use the function from the action window when starting the programme or from the [File] menu, if you wish to

create a new HDF project. In both cases, you will first be shown a selection window. The storage location and

project name can be set in this window. 

Another window will be displayed where you can select the desired operating mode. 
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You can choose from the following:

EASY-Mode

EASY-Mode is the most simple operating mode. It is intended for small security system installations. In

EASY-Mode up to 30 alarm sensors can in principle be connected to one or more alarm centres (HDF-

BUZZER or HDF-SPEECH). The connection only requires a simple pairing at the push of a button on the

respective sensor. All alarm sensors on an alarm centre have the same alarm behaviour. An individual alarm

form is not possible for individual alarm sensors. Alarm sensors that have already been created cannot be

deleted individually.

The HDF-CONFIGURATOR software in EASY-Mode is only required for changing the alarm behaviour of the

respective HDF-BUZZER or HDF-SPEECH unit. This change is then valid for all "paired" alarm sensors.

MULTI-Mode

The use of the HDF-CONFIGURATOR software is mandatory in MULTI-Mode. The complete installation of

the security system is initially planned with the software. After completion of the planning the user can enter

the hardware identifiers (ID codes) of the individual Human Detector Flex components. The project data

generated in this way can then be transferred to the various alarm centres (HDF-BUZZER or HDF-SPEECH)

with the HDF-CONFIGURATOR software via USB cable.

The MULTI-Mode provides the user with a high degree of flexibility. Each sensor and each alarm centre can

be individually programmed. The maximum number of alarm sensors per alarm centre is 200. The HDF-

CONFIGURATOR software also generates up-to-date project documentation.

PROFI-Mode

The use of the HDF-CONFIGURATOR software is also mandatory in PROFI-Mode. The PROFI-Mode is a

powerful extension of the MULTI-Mode. An HDF-AMD alarm management system is installed in addition. The

device monitors and evaluates all alarm and system messages. The information obtained in this way is

forwarded specifically to a local or external control center. The settings required for commissioning are made

with the HDF-CONFIGURATOR software. The functions of the MULTI-Mode installation are completely

retained in PROFI-Mode. Updating from EASY to MULTI-Mode or from MULTI to PROFI-Mode is possible at

any time. Moving in the opposite direction is feasible, but will always lead to restrictions in functionality.

The project password can then be assigned. Move the "Password Protection" slider to the ON position.

Re-enter the password after the first entry. It is important that both password entries are identical. Only then

can the project be created by pressing the [Create Project] button. 

"General Information" is now displayed in the communication window. These can be completed or changed

at any time. 
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The following entries are possible:

Project Mode

Three operating modes (EASY, MULTI and PROFI-Mode) are available. The display of the function area and

the selection of menu items in the additional menu change depending on the selected mode.

Institution

Input field for the name of the institution (e.g. Art Gallery XYZ, new annex)

Builder

This field may contain the name of the installing company (e.g. Smith Security Technology).

Project

Input field for the project name (e.g. Securing new picture hall)

Version

Input field for a version number. It may be necessary to plan different versions, depending on the project. 

Responsible Employees

Input field for the responsible employee in the project

Date

The date can be entered manually (format: dd.mm.yyyy) or selected from a calendar. The date format adjusts

automatically in other languages.

Comments

Comments can be saved in this input field.

Note:
All input fields have a maximum length of 500 characters. If these cannot be displayed completely, place the

cursor in the field and scroll through the input field with the [Left Arrow] and [Right Arrow] keys.
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Open HDF project

Use the function from the action window when starting the programme or from the [File] menu, if you want to

open an existing [HDF project]. In both cases a selection window will be displayed.

Select the desired project file (file extension *.hdfproj) and confirm your selection by pressing [Open].

Save HDF project

The project is automatically saved by selecting this menu item. No additional window is displayed. The HDF

project is saved under the current name. Older files are overwritten without a confirmation prompt. 

Note:
If there is an "*" after the project name in the top line of the screen, this means that the project still contains

unsaved data. Example: HDF-CONFIGURATOR - Backup.hdfprj*

Save HDF project as

A selection window appears after selecting the menu item [Save HDF project as]. There you can enter the

project name and select a suitable storage location. Confirm your entry by pressing the save button. 
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Change HDF project password

The HDF project password can be changed at any time. The current password needs to be entered first. Then

the new matching password needs to be entered twice. The entries are confirmed by pressing [Change

Password].

The function can still be executed, even if a password has not been set yet for the project. A current password

does not need to be entered in this case. 

Notes:
The password consists of at least 6 characters. Please choose a "strong" password, e.g. consisting of

random combinations of numbers, letters and special characters. 

The selected password is the project password. It is used to store and protect the project. It is not to be

confused with the passwords of the alarm centres (HDF-BUZZER and HDF-SPEECH) and the password of

the alarm management system (HDF-AMD).

Save the password in a secure location. If the password is lost, the project can no longer be opened

and edited.

Print HDF project

A Project created with the Human Detector Flex system can be printed at any time. All components and

their links and dependencies are clearly described in the project documentation. The documentation shall be

in the respective language selected.

If desired, password fields can be added to the documentation. The respective passwords can be entered

manually in these fields by the user. The "General Information" is also printed out. There is a signature

field at the end of the document. There the user can confirm the data correctness by entering date, name and

signature.

The Windows system outputs the print. Various printers and also PDF tools can be controlled. 

The Human Detector Flex system is one of the few systems that automatically generates complete and

seamless project documentation.

Safety instructions:
Handle the project printouts with care and diligence. These contain all security-relevant information, excluding

passwords.
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Only enter the passwords manually if you absolutely wish to do so. Please note that the passwords of the

HDF alarm units are not stored in the HDF-CONFIGURATOR software. Store the passwords in a different

location for a higher level of security.

If you forget the passwords, there is no possibility to bypass a missing password.

The Human Detector Flex system - or individual parts of it - must be reset to the delivery state in this case.

All programming steps need to be carried out again. A project documentation which was created previously

would be of great help here. 

Add and manage HDF sensors

There are two ways to access the function for adding HDF sensors:

· Select [Add HDF Sensor] from the [Edit] menu.

· Press the [�  Sensor] Button in the configuration window (on the left of the screen).

In both cases, a menu with various configurable input fields opens in the communication window. A new

sensor is added to the vertical sensor list displayed in the configuration window. It is initially called "Sensor"

and is highlighted in green for enhanced detectability. 

If a HDF sensor was added by mistake or an already existing HDF sensor needs to be deleted, press the red

recycle bin symbol or the right mouse button and select [Delete]. Before the deletion process takes place,

you need to confirm a security query with "Yes". This prevents the accidental deletion of items. 

Adding the different HDF sensors is described in the following two chapters. In larger installations with a high

number of HDF sensors it could be of use to change the sensor order. Move the mouse cursor to the left or

right of the sensor name in this case. A Ý[arrow-up] or Þ[arrow down] symbol appears. If you press the left

mouse button on one of the arrow symbols, for example, the HDF sensor is moved accordingly in the sensor

list.



                                      Instruction Manual

Security made easy  - Human Detector Flex 23 / 51

As long as the mouse is placed on a sensor field in the column with the HDF sensors, you can press the right

mouse button. The following action window is displayed.

You can edit the settings of the sensor module, duplicate the HDF sensor or delete the complete HDF sensor.

The [Duplicate] function enables you to quickly create similar sensors without having to re-enter details each

time. This is useful for larger backup tasks.

Add HDF sensors with one alarm channel

In principle, the Human Detector Flex System uses sensors with one or two channels. Depending on the

number of channels, one or two different alarm messages can be transmitted. 

Sensors with one alarm channel:

HDF-DOOR alarm module for monitoring doors, flaps and inspection hatches

HDF-SHOCK alarm module with mechanical position and vibration sensor 

HDF-3D PROTECT microprocessor-controlled 3D acceleration sensor (structure-borne sound)

HDF-OPTICAL non-contact optical sensor for monitoring paintings/pictures

HDF-HANG alarm module for monitoring objects on gallery rails

HDF-TOUCH capacitive alarm module (field change sensor)

A special role take 

HDF-REMOTE panic handset (SOS call) and

HDF-ANTIJAM Jamming Detection Unit.

These are devices that also operate with one alarm channel. They can be applied like a conventional sensor.

Information on the individual sensor modules can be found in the individual manuals or on

www.human-detector.com.

Important note:
HDF-ANTIJAM should only be used in conjunction with HDF-AMD. HDF-ANTIJAM generates coded signals

at regular and short intervals that are used to monitor the radio room. Monitoring is automatically activated as

soon as HDF-ANITIJAM is linked with HDF-AMD.

HDF-ANTIJAM must not be linked to an HDF alarm centre. In this case, it would receive alarm

messages at short intervals.
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The following entries are necessary to add an HDF sensor with one channel:

Sensor Type

Press the input field to select the sensor type. A window is displayed in which you can determine the desired

sensor type.

Name

Create and enter a short and meaningful name. The word "Sensor" will be replaced in the sensor list by your

specified name. Examples of meaningful names: "Rubens painting, Hall 1" or "Laser scanner left wall".

Note:
The sensor name "Laser scanner left wall" indicates an HDF-EXTERN sensor to which a laser scanner is

connected.

Hardware ID

The hardware ID consists of a letter followed by a 6-digit hexadecimal number. The letter in the first position is

determined by the sensor type and cannot be changed at this point. The 6-digit hardware ID can be found on

the housing of the sensor module (sticker on the bottom), inside the sensor module (small sticker on the

circuit board) and on the sensor packaging. The hardware ID can consist of the numbers 0...9 and the letters

A, B, C, D, E and F. 

Enter the hardware ID in the field highlighted in red. It doesn't matter whether you write the letters in upper or

lower case. The HDF-CONFIGURATOR software converts all entries into capital letters. 

Important notes:
Entering the hardware ID is mandatory if you want to transfer the data of your project to the alarm centres

(HDF-BUZZER or HDF-SPEECH) or to the alarm management system (HDF-AMD). If you want to plan

different configurations without a direct transfer you can initially forgo entering the hardware ID.

Make sure that you enter the hardware ID correctly. Errors in the input lead to a malfunction in the

evaluation of the alarm messages.

The following additional input fields are displayed, if the project you are planning is running in PROFI-Mode or

if there is an HDF-AMD alarm management system in the installation:

SIA-DC09 configuration

The forwarding of alarm messages to a SIA DC09-Server can be enabled via a slide switch. If this function is

activated the following entries are displayed.
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Assigned HDF-AMD in Range

Click on the input field. If you have created one or more HDF-AMD, they will appear in the selection field.

Select the HDF-AMD that is placed within safe range (good reception) of the sensor module. Only one HDF-

AMD can be assigned per sensor module.

Alarm Area

Click on the input field. If you have created alarm areas, they now appear in the selection field. Select the

alarm area where the HDF sensor is located. If you cannot find a suitable alarm area, you can create one in

the [Alarm areas] menu. Only one alarm area can be assigned per sensor module.

Message

The entry of a message is mandatory and limited to a maximum of 500 characters. In the case of an alarm in

PROFI-Mode the message will be appended as additional information to the SIA-DC09 message and serves

to facilitate the classification of the alarm. A meaningful message could be: „Rubens painting in room 3,

right hand wall“.

Event qualifier

The event qualifier in the sense of Ademco CID can have the values 1, 3 or 6 depending on the use case.

1 = New event

3 = Cancellation alarm

6 = Recurring event

Event code

The individual meanings can be found in the relevant CID event code tables.

Group

Two hexadecimal digits to classify the alarms into groups.

Zone

Three hexadecimal digits to classify the alarms into zones.

Save the project after entering all relevant information.

Add HDF sensors with 2 alarm channels

In addition to the sensors with one alarm channel, the Human Detector Flex system also has alarm

modules with two channels. These sensors can transmit two different alarm messages. 

Sensors with two alarm channels are:

HDF-EXTERN alarm module for connecting external sensors and laser scanners

HDF-WIRE alarm module for the evaluation of tear-off wires

Adding an alarm module with two alarm channels is identical to adding only one alarm channel.
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HDF sensors with two channels offer the possibility of switching each individual alarm channel (channel 1 and

channel 2) on and off via one slide switch each. 

If an alarm channel has been switched on, an individual message with a maximum length of 500 characters

can be saved. Examples of meaningful messages are: "Gallery wall left hand side alarm" or "Gallery wall

right hand side alarm". These alarm messages could belong to an HDF-EXTERN alarm module connected

to two laser scanners. Sensors with two outputs (pre-alarm and main alarm) can also be connected to an

HDF-EXTERN alarm module.

Save the project after entering all relevant information.
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Add and manage HDF alarm centres

Adding HDF alarm control units follows the same procedure as adding HDF sensors. All created alarm

centres are displayed in the horizontal bar of the configuration field.

The function for adding HDF alarm centres can be used in two ways:

· Select [Add HDF-BUZZER] or [Add HDF-SPEECH] from the [Edit] menu.

· Press the [�  Alarm Device] button in the configuration window (top of the screen). You can now select

from the list displayed. As soon as you edit a project that is in PROFI-Mode, you can also add the alarm

management system HDF-AMD with this function. 

In both cases, a menu with various configurable input fields opens in the communication window. The

horizontal list of alarm devices displayed in the configuration window is thereby extended by one alarm unit.

This is initially called "BUZZER" or "SPEECH" and is highlighted in green for enhanced detectability. 

Note:
The settings described on the next pages show the basic setting of the respective alarm centre. These initially

apply to all linked HDF alarm sensors. However, the settings of individual sensors can be set differently, if

required. It is not possible to change details of the basic configuration. It is rather a matter of switching

complete functions of the basic configuration on or off. Any changes to the details would lead to confused

operational behaviour.

Add HDF-BUZZER

After you have added an HDF-BUZZER alarm centre, you can start setting up the alarm centre in the

communication window. 

Note:
The appearance of the entries in the communication window can vary greatly from case to case. At the time of

the initial call, most inputs are deactivated by slide switches and are not visible. If you change the status of

the slide switch with the mouse (switch on function), more and more input fields become visible.

In this manual we will describe all inputs in their order sequence.
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If you have added an HDF alarm centre by mistake or an already existing component needs to be deleted,

press the red recycle bin symbol or the right mouse button and select [Delete]. Before the deletion process

takes place, you need to confirm a security query with "Yes". This prevents the accidental deletion of items. 

Adding HDF-BUZZER and HDF-SPEECH is described in the following two chapters. In larger installations

with a high number of HDF alarm centres it could be useful to change the alarm centre order. Move the

mouse cursor to the left or right of the alarm centre name in this case. A Ü Right arrow or Û Left arrow

symbol is displayed. If the left mouse button on one of the arrow symbols is pressed, the HDF alarm centre is

moved accordingly in the alarm devices list. 

As long as the mouse is placed on a field in the line with the HDF alarm devices, you can press the right

mouse button. The following action window is displayed.

You can edit the settings of the alarm device and duplicate or delete the HDF alarm device. The [Duplicate]

function enables you to quickly create similar alarm devices without having to re-enter details each time. This

is useful for larger backup tasks.

The following entries are necessary to add an HDF alarm centre:

Name

Create and enter a short and meaningful name. The words "Buzzer" or "Speech" are replaced in the alarm

device list with your specified name. Examples of meaningful names: "Alarm siren main building, hall 1" or

"Siren gallery wall".

Hardware ID

The hardware ID consists of the letters BUZ- followed by a 6-digit hexadecimal number. The first letters are

determined by the alarm centres and cannot be changed at this point. The 6-digit hardware ID can be found

on the housing of the alarm device (sticker on the bottom), inside the alarm device (small sticker on the circuit

board) and on the alarm centre packaging. The hardware ID can consist of the numbers 0...9 and the letters

A, B, C, D, E and F. 



                                      Instruction Manual

Security made easy  - Human Detector Flex 29 / 51

Enter the hardware ID in the field highlighted in red. It doesn't matter whether you write the letters in upper or

lower case. The HDF-CONFIGURATOR software converts all entries into capital letters. 

Important notes:
Entering the hardware ID is mandatory if you want to transfer the data of your project to the alarm centres

(HDF-BUZZER or HDF-SPEECH) or to the alarm management system (HDF-AMD). If you want to plan

different configurations without a direct transfer you can initially forgo entering the hardware ID.

Make sure that you enter the hardware ID correctly. Errors in the input lead to a malfunction in the

evaluation of the alarm messages. 

Description

The description field allows for additional explanatory information. Further information about the alarm centre

can be stored here. 

Note:
Most input fields have a maximum length of 500 characters. If these cannot be displayed completely, place

the cursor in the field and scroll through the input field with the [Left Arrow] and [Right Arrow] keys.

Alarm Confirmation Allowed

With the slide switch set to On, the alarm centre supports the direct acknowledgement of alarms at the HDF

alarm centre. For this purpose, a switch needs to be connected to the corresponding input of the alarm

centre.

Note:
Further information can be found in the operating instructions for the HDF-BUZZER and HDF-SPEECH alarm

centres.

Arm/Disarm Allowed

With the slide switch set to On, the alarm centre supports the direct arming and disarming at the HDF alarm

centre. For this purpose, a switch needs to be connected to the corresponding input of the alarm centre. 

Note:
Further information can be found in the operating instructions for the HDF-BUZZER and HDF-SPEECH alarm

centres.

Buzzer Alarm

With the slide switch for the buzzer alarm switched to On, the following input fields are displayed:

Alarm Sound

Execute a mouse click in the input field. The various alarm sounds are displayed. You can choose the

following:

· Continuous alarm sound

· Alarm sound with 0.25 second interval

· Alarm sound with 0.5 second interval

· Alarm sound with 1.0 second interval

Note:
The interval time indicates the respective length of the on and off phase of the siren sound. A 1.0 second

interval means that the siren sound changes very second from on to off (and vice versa).
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Alarm Duration

The alarm duration indicates the total length of the alarm sound. It is independent of the selected alarm

sound.

Note:
Independent of the input (e.g.: 3.567 seconds), the actual value is calculated to one decimal place (here e.g.:

3.5 seconds). If you want to use an alarm sound with interval, it is recommended to select a significantly

longer alarm duration than the interval duration.

Voice Alarm

If you install an HDF-BUZZER alarm centre, you can make entries here, but they are if no effect. Alarm

messages in voice form (mp3 format) are reserved for the HDF-SPEECH device. In this case, the slide

switch should be set to Off. 

Note:
The reason why the menu item is listed with the HDF-BUZZER configuration is due to the compatibility of the

two alarm centres. If desired, you can replace the HDF-BUZZER with a HDF-SPEECH at a later time. The

basic programming can then be retained. 

The following inputs and functions are identical for all three relays. Each HDF alarm centre has three relays

that are programmed completely independently of each other. This manual will therefore be limited to a

detailed description of the functions based on relay 1. 

Relay 1 Enabled

Use the slide switch to set relay 1 on or off. With relay 1 activated the following additional input fields are

displayed:

Triggers On

Execute a mouse click in the input field "Triggered On". A selection window appears with possible reasons

for the triggering. Select a reason for triggering from the following list:

· Triggers on "Alarm"

· Triggers on "Alarm Confirmation”

· Triggers on "System Armed”

· Triggers on "System Disarmed”

· Triggers on "Battery empty”

Note:
With this powerful function, external status indications can be realised via indicator lights, for example.

NC (normally closed)

The option "NC (normally closed)" determines the idle state of the relay. The relay is closed when the slide

switch is set to On. If the reason for tripping then occurs, the relay drops out and opens. The same would

happen if the power supply to the HDF alarm centre is interrupted.

Note:
The NC output generated in this way is the standard output for connecting to external intruder alarm systems

(EMA). In this case, the HDF alarm centre behaves like a standardised NC detector.

Relay Output Duration

The relay output duration indicates the total length of the switching process. It is independent of the setting

selected under "Toggle Relay".
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Note:
Independent of the input (e.g.: 3.567 seconds), the actual value is calculated to one decimal place (here e.g.:

3.5 seconds). 

Toggle Relay

You can use this slide switch to set the relay on and off for a toggling behaviour. If the relay is toggled, you

can set the switching interval in the next input field.

Toggle Interval

You can choose any toggle interval. The toggle interval indicates the time for the relay changing from on to off

(and vice versa). A toggle interval of 1.0 second means that the relay changes its switching state every

second.

Note:
Independent of the input (e.g.: 3.567 seconds), the actual value is calculated to one decimal place (here e.g.:

3.5 seconds). If you want to toggle the relay, it is advisable to select a significantly longer switching duration

than the interval duration.

Relay 2 Enabled

All entries are identical to the functions described above in "Relay 1 Enabled". However, they now refer to

relay 2.

Relay 3 Enabled

All entries are identical to the functions described above in "Relay 1 Enabled". However, they now refer to

relay 3.

Save the project after entering all relevant information.
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Add HDF-SPEECH

Adding the HDF-SPEECH is identical to adding the HDF-BUZZER. With the only exception that voice alarm

is supported. The HDF-SPEECH alarm centre has an additional mp3 voice output card. Up to three different

voice or sound messages can be stored in mp3 format. Different voice or sound messages can therefore be

assigned to different HDF sensors.

The individual steps for adding the HDF-SPEECH are not repeated here for reasons of simplicity. Please refer

to the previous chapter "Add HDF-BUZZER". The steps described there are identical.

The following additional inputs are only supported by the HDF-SPEECH:

Default Voice File

After clicking in the input field, you can select the desired alarm file from the voice and sound messages

001.mp3, 002.mp3 and 003.mp3.

To replace the mp3 voice files, connect the voice card to your personal computer using the micro-USB cable

supplied. You can now open the voice card memory with the Windows Explorer App and replace the mp3

files.

The memory of the voice card contains the mp3 files 001.mp3, 002.mp3, 003.mp3 and 004.mp3. If other

files are present here, they are of no relevance for the HDF-SPEECH speech output. 

The mp3 files 001.mp3, 002.mp3 and 003.mp3 contain the three alarm messages. They can be selected

with [Default Voice File]. The file 004.mp3 contains a confirmation tone. It sounds when an alarm on an

HDF-SPEECH is acknowledged via a connected switch.

You can replace all four mp3 files. However, the four mp3 files may only be copied together. This is

important because the four files are indexed in the order in which they are copied. If you want to replace a

single file, download all four mp3 files from the language card and replace one of them on your personal

computer. Then copy all four mp3 files back to the language card in one. The language map then indexes

them in the correct order.

In order to do this the housing of the HDF-SPEECH first needs to be opened. 

Previous Alarm can be interrupted

This slide switch allows you to set a possible interruption of long alarm outputs of the voice unit on or off in

case of a new alarm within the current voice output. 
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Important notes:
If you want to issue long voice alarms without interruption with the HDF-SPEECH, it is recommended that you

also switch on the buzzer alarm with a short siren tone. If another alarm is triggered during the long voice

output, it is indicated by the short siren tone. The sound only slightly interferes with the voice output. 

The follow-up alarm would not be reported without the short buzzer alarm.

Save the project after entering all relevant information.

Sensor configuration

After you have created all HDF sensors and HDF alarm centres, start linking the components. The HDF-

CONFIGURATOR software offers the convenience and flexibility to expand existing configurations at any time

or to cancel or change links. There is no need to follow any particular order or procedure. The flexible HDF-

CONFIGURATOR software provides support for every phase of your project.

The picture above shows a simple installation in PROFI-Mode. The alarm module "Showcase door left" is

linked to the "Siren Corridor" and "Speech alarm". The "Painting gallery" sensor is currently not yet

connected to one of the alarm centres. Both HDF sensors are assigned to the HDF-AMD.

As long as you click in the horizontal and vertical crossing point, you are able to unlock or change the link.

Provided the link field is empty, a slide switch appears first that enables you to activate the assignment of the

HDF sensor for the selected HDF alarm device. As long as this has not been done, alarm messages from the

alarm sensor at the said alarm device are not processed. 

To assign the HDF sensor the slide switch needs to be activated. The input field in the communication field

expands as a result. The slide switch [Custom Configuration] is initially set to "Off". This means that the

sensor uses the default settings of the alarm centre. All alarms issued correspond to the default setting of the

respective HDF-BUZZER or HDF-SPEECH.

If you set the slide switch for [Custom Configuration] to "On", the colours of the slide switches below

change. Functions that were enabled in the basic configuration of the alarm centre can now be changed

individually for the selected HDF sensor. 



                                      Instruction Manual

Security made easy  - Human Detector Flex 34 / 51

With the exception of the mp3 file for the voice alarm on the HDF-SPEECH, however, basic settings (such as

alarm times or switching times) cannot be changed. This can be used to output different voice messages for

different sensors. It is also possible, for example, to connect external sensors with a pre-alarm detector (e.g.

laser scanner with several curtains) to an HDF-EXTERN alarm module. In this case, there could be a two-

stage alarm with a pre-alarm. 

Any changes to the details beyond this, such as the alarm, interval and switching times, would lead to a

completely confused operational behaviour. The Human Detector Flex technology therefore does not utilize

these functions.

Note: 
Relays that trigger for a reason other than "alarm" are excluded from the custom configuration. This makes

sense since higher-level processes are monitored here.

A possible input field (without voice alert) could have the following layout:

New links and changes to the components or links are displayed in the respective fields of the box. The entire

behaviour of the installation is therefore visible at a glance.

Explanation of the abbreviations in the link fields of the alarm centres:

CH1: Alarm channel 1

CH2: Alarm channel 2 (only for HDF-EXTERN and HDF-WIRE)

B Buzzer alarm

V ( ) Voice or sound alarm (mp3 file)

F1 Voice and sound file 001.mp3

F2 Voice and sound file 002.mp3

F3 Voice and sound file 003.mp3

R1 Relay 1

R2 Relay 2

R3 Relay 3

Save the project after entering all custom settings.
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Important notes:
HDF-ANTIJAM should only be used in conjunction with HDF-AMD. HDF-ANTIJAM generates coded signals

at regular intervals that are used to monitor the radio room. Monitoring is automatically activated as soon as

HDF-ANITIJAM is linked with HDF-AMD.

HDF-ANTIJAM must not be linked to an HDF alarm centre (HDF-BUZZER or HDF-SPEECH). In this

case, it would produce alarm messages at short intervals.

Programming HDF-BUZZER/SPEECH

After having specified all settings and links, they can be transferred to the HDF alarm centres. Programming

the HDF-BUZZER and HDF-SPEECH is necessary in all operating modes (EASY, MULTI and PROFI-Mode).

The HDF-AMD, on the other hand, only needs to be programmed in PROFI-Mode.

Follow these steps to program the HDF alarm centres:

· Open the housing cover of the alarm centre.

· Connect the mini-USB socket for publishing to your personal computer. The required cable is included in

the scope of delivery of the HDF alarm centre. 

· Switch on the alarm centre and wait a moment until the green operating LED illuminates.

· The yellow indicator LED illuminates when a data transmission is in progress.

· In the HDF-CONFIGURATOR software, press the "rotating arrow" next to the input field "Select

Device".

· The corresponding HDF alarm centre is detected and displayed.

· Enter the correct password. 
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Notes:
Programming is not possible without the correct password. 

The default password is: HDF-Admin

· Press the [Programming button] in the HDF-CONFIGURATOR software.

· The software indicates the successful programming of the HDF alarm unit.

· You can now switch off the alarm centre, remove the mini-USB cable, close the casing of the unit and

mount the unit in its original position. 

If you have changed the configuration in your project, the update of the HDF alarm centres should be carried

out on all units that are affected by the changes. Alarm centres that operate in other areas, for example, and

have not been changed or have not undergone any changes in the linked sensors do not need to be

reprogrammed.

Important notes:
Opening the housing of the HDF alarm centre constitutes an additional security measure to prevent system

tampering. The enclosures should not be left open for convenience or quick access. 

Ensure that the USB connection between the personal computer and the HDF alarm centre is not

disconnected during programming. Also ensure that the programming process is not interrupted for any other

reason. Otherwise, data loss or even complete failure of the alarm centre can occur.

Check all settings after programming has been carried out. Test the programmed HDF alarm centres

for this. Possible errors can then immediately be detected.

Change HDF-BUZZER/SPEECH password

Passwords should be changed at regular intervals or after irregular events (e.g. the departure of an employee

with knowledge of passwords). Changing the password of the HDF alarm centres follows largely the

procedure for changing the project password.
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Follow these steps to change the passwords of the HDF alarm centres:

· Open the housing cover of the alarm centre.

· Connect the mini-USB socket for changing the password to your personal computer. The required cable is

included in the scope of delivery of the HDF alarm centre. 

· Switch on the alarm centre and wait a moment until the green operation LED illuminates.

· The yellow indicator LED illuminates when a data transmission is in progress.

· In the HDF-CONFIGURATOR software, press the "rotating arrow" next to the input field "Select

Device".

· The corresponding HDF alarm centre is detected and displayed.

· Enter the "Current Password".

Important note:
The default password is: HDF-Admin

Note:
It is not possible to change a password without the correct password. 

· Enter the new password and confirm the password.

Notes:
The password consists of at least 6 characters. Please choose a "strong" password, e.g. consisting of a

random combination of numbers and letters. The selected password is the device password of the HDF alarm

centre. It is used for programming the devices. It is not to be confused with the project password and the

password of the alarm management system  (HDF-AMD). Save the password in a secure location. 

If the password is lost, it can no longer be changed. The device will then have to be reset to factory

settings.

· Press the [Change Device Password] button in the HDF-CONFIGURATOR software.

· The software indicates that the device password has been successfully changed.

· You can now continue with your work or switch off the alarm centre, remove the mini-USB cable, close the

casing of the unit and mount the unit in its original position. 
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Read HDF-BUZZER/SPEECH configuration

The basic steps for reading out the configuration of an HDF alarm centre are identical to programming the

unit.

Follow these steps for reading out the configuration of an HDF alarm centre:

· Open the housing cover of the alarm centre.

· Connect the mini-USB socket for reading to your personal computer. The required cable is included in the

scope of delivery of the HDF alarm centre. 

· Switch on the alarm centre and wait a moment until the green operation LED illuminates.

· The yellow indicator LED illuminates when a data transmission is in progress.

· In the HDF-CONFIGURATOR software, press the "rotating arrow" next to the input field "Select

Device".

· The corresponding HDF alarm centre is detected and displayed.

· Enter the correct password. 

Note:
It is not possible to read the configuration without the correct password. 

· Press the [Read Configuration] button in the HDF-CONFIGURATOR software.

· The software displays the configuration of the HDF alarm centre in the centre of the window. You can

scroll through this window to view all entries.

· You can add the configuration to the existing project, if desired. To do so, press the [Add To Project]

button in the HDF-CONFIGURATOR software.

· You will be asked whether the existing project information should be retained or whether the settings in

the project should be overwritten.

Note:
Before rewriting the data, you should backup the current project with [Save as].

· You can now continue with your work or switch off the alarm centre, remove the mini-USB cable, close the

casing of the unit and mount the unit in its original position.
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Setting up HDF alarm management

The Human Detector Flex Technology enables the user to utilize a cost-effective and very efficient alarm

management system. All alarm messages are monitored here by one or more central alarm management

devices (HDF-AMD). The alarm messages are forwarded to various smartphones and other end devices. 

The so-called PROFI-Mode provides the option to forward alarm messages silently to the respective security

personnel. "Alarm-by-Silence" delivers a high level of protection, relieves your security personnel and leads

to a relaxed exhibition atmosphere that is not disturbed by alarm messages.

Provided you use the Human Detector Flex Alarm management, you should create the project in PROFI-

Mode (see "Creating a new HDF project") or switch to PROFI-Mode at a later time (see "Project

Summary"). You can add an HDF-AMD device by pressing the button shown below.

You can also press the [Add HDF-AMD] button in the [Edit] menu.

Important safety note!
The installation of the HDF-AMD should only be carried out by a trained and experienced technician.

Add HDF-AMD

An input screen appears in the communication window, which is used to enter the HDF-AMD configuration

data.
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If you have added an HDF-AMD by mistake or an already existing component needs to be deleted, press the

red recycle bin symbol or the right mouse button and select [Delete]. Before the deletion process takes

place, you need to confirm a security query with "Yes". This prevents the accidental deletion of items. 

The following entries can be made:

Name

Create and enter a short and meaningful name. The word "AMD" will be replaced in the alarm device list by

your specified name. A meaningful name could be, for example, "HDF-AMD Main Building".

Hardware ID

The hardware ID consists of the letters AMD- followed by a 6-digit hexadecimal number. The first letters are

determined by the alarm management unit and cannot be changed at this point. The 6-digit hardware ID can

be found on the housing of the alarm management unit (sticker on the bottom), inside the alarm management

unit (small sticker on the circuit board) and on the alarm management unit packaging. The hardware ID can

consist of the numbers 0...9 and the letters A, B, C, D, E and F. 

Enter the hardware ID in the field highlighted in red. It doesn't matter whether you write the letters in upper or

lower case. The HDF-CONFIGURATOR software converts all entries into capital letters. 

Important notes:
Entering the device ID is mandatory if you want to transfer the data of your project to the alarm management

system (HDF-AMD). If you want to plan different configurations without a direct transfer you can initially forgo

entering the hardware ID.

Make sure that you enter the hardware ID correctly. Errors in the input lead to a malfunction in the

evaluation of the alarm messages. 

Description

The description field allows for additional explanatory information. Further information about the HDF-AMD

can be stored here. 

Once the HDF-AMD is automatically connected to the internet via DHCP (Dynamic Host Configuration

Protocol) all required entries have been made. 

If you want to use a static IP address, the [DHCP slide switch] needs to be set to "Off".

The following additional entries are required for this:

Static IP

Enter the IPv4 address followed by a suffix for the subnet mask.

Gateway

Enter the IPv4 address of the gateway here, if you use a gateway to connect to the internet. 

DNS-Server

Enter one or more DNS servers here. Multiple DNS servers are entered separated by a space.

Important notes:

Setting up a static IP address for your HDF-AMD should only be performed by an experienced network

engineer. Appropriate expertise and a detailed knowledge of the IP structure of your home network, including

the security settings used (firewall, filter, whitelist, etc.), are mandatory. 

SIA-DC09 server (IP/FQDN)

Enter the IP address or URL of the SIA server here.

Port

Here the port at the SIA server is required.

Transmission Protocol

Your choices are TCP or UDP. Information on which protocol to choose can be obtained from your control

center operator.
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Report missing sensors

Activate this slide switch if you want the control center to be informed every time a sensor skips a heartbeat.

The alarm will be repeated every twenty minutes until the next signal from sensor is received.

Report weak batteries

Activate this slide switch if you want the control center to be informed in case of a sensor’s weak battery. The

alarm will be repeated every twenty seconds until the battery is replaced.

Transmit timestamp

This function attaches a timestamp to the SIA-DC09 message. This is mandatory with encrypted messages.

Encryption

Activate this slide switch to encrypt messages. If this option is active the next to options will be available.

Otherwise you can skip the next two options.

Algorithm

Choose between AES128-CBC and AES256-CBC. The choice must be identical with the settings in the

control center.

Key (HEX-Representation)

Enter your key in hexadecimal representation. Mind the key length of the different algorithms.

Link supervision

With this slide switch you can activate a periodic message to the control center to test the connection. If this

option is active another option called Supervision interval (sec.) appears with which you can set the interval

between the periodic messages.

Resent failed messages

With this function you can resend messages which have not been acknowledged by the control center. If this

function is active the following two options appear. Otherwise you can skip them.

Number of resend attempts

Enter a number of retries to send a message before it is considered failed.

Interval between resend attempts

Enter a timespan that will be waited until the next resend attempt will be undertaken.

Account number

Enter the unique Identifier of the HDF-AMD at the control center here, which you will get get from the control

centers operator. This identifier ist mandatory.

Account prefix

This optional value helps classifying devices at the control center. If you did not get a value for this from your

control center operator, leave this field empty.

Receiver number

This optional value helps classifying devices at the control center. If you did not get a value for this from your

control center operator, leave this field empty.

Save the project after entering all relevant information.
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Creating alarm areas

In order to structure and organise a large number of sensors, it is possible to locate sensors in alarm areas.

The HDF-CONFIGURATOR software enables you to completely map your property with several buildings,

exhibition halls, rooms and room areas, if applicable. This enables the detailed allocation of alarm areas.

Familiarise yourself with the various editing options and symbols. 

The [confirmation symbol] completes an saves the entry. If it is a confirmation prompt (confirmation when

deleting an entry), the [confirmation symbol] is highlighted in red.

The [cancel symbol] exits an entry without saving it.

The [edit symbol] opens a saved entry and enables its editing.

The [delete symbol] deletes an entry. Before the final deletion, there is a confirmation prompt which needs to

be confirmed by pressing the [confirmation symbol] highlighted in red.

Important notes:
If you delete an entry that has subordinate entries (sub-entries), these will be automatically deleted as well.

In addition, symbols such as [+] and [-] are available. Use these to open and close the respective sub levels.

With the button [Add New Alarm Area] a new alarm area is created on the same level.

Familiarise yourself with the input system. With a little practice, you will succeed in transforming any building

structure into a clearly organized structure.  Only assign building, room and area names that enable

unambiguous allocation. Ensure at the end of your work that all entries are completed. Then safe your project.

Note:
If you have protection tasks that cover several buildings or areas and a comprehensive alarm management

system (e.g. museums with branch offices) is not required, it would be best to divide the project into several

projects.
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Assign alarm areas to HDF sensors

After adding the HDF-AMD and setting up the alarm areas, the individual sensors need to be linked to the

alarm areas and the HDF-AMD.

The required action window is displayed when you click on the desired sensor in the sensor list.

You can apply the following settings:

SIA-DC09 configuration

The forwarding of alarm messages to a SIA-Server can be enabled via a slide switch. If this function is

activated the following entries are displayed.

Assigned HDF-AMD in Range

Click on the input field. If you have created one or more HDF-AMD, these will appear in the selection field.

Select the HDF-AMD that is within safe range (good reception) of the sensor module. Only one HDF-AMD

can be assigned per sensor module.

Alarm Area

Click on the input field. If you have created one or more alarm areas, these will appear in the selection field.

Select the alarm area where the HDF sensor is located. If you cannot find a suitable alarm area, you can

create one in the [Add Alarm Areas] menu. Only one alarm area can be assigned per sensor module.

Message

The entry of a message is mandatory and limited to a maximum of 500 characters. In the case of an alarm in

PROFI-Mode the message will be appended as additional information to the SIA-DC09 message and serves

to facilitate the classification of the alarm. A meaningful message could be: „Rubens painting in room 3,

right hand wall“.

Event qualifier

The event qualifier in the sense of Ademco CID can have the values 1, 3 or 6 depending on the use case.
1 = New event

3 = Cancellation alarm

6 = Recurring event
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Event code

The individual meanings can be found in the relevant CID event code tables.

Group

Two hexadecimal digits to classify the alarms into groups.

Zone

Three hexadecimal digits to classify the alarms into zones.

Save the project after entering all relevant information.

Programming HDF-AMD

After having applied all settings and links, they can be transferred to the HDF-AMD. Press the

[Programming HDF-AMD] in the [Edit] menu or select the [Program] in the additional menu and then

[Programming HDF-AMD].

To program the HDF-AMD, proceed as follows:

· Open the housing cover of the HDF-AMD.

· Switch on the HDF-AMD and wait a moment until the green operation LED illuminates.

· Briefly press the control button near the right antenna. The yellow control LED illuminates and the HDF-

AMD is in programming mode.

· The connection to the HDF-AMD is via the wireless network. It is therefore important that your personal

computer is within radio range of the HDF-AMD. After five minutes of inactivity the wireless network will be

shutdown automatically.
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· In the HDF-CONFIGURATOR software press the “rotating arrow” next to the input field “Select HDF-

AMD”.

· After a short moment the corresponding HDF-AMD can be selected from the drop-down-menu.

· If the HDF-SUPERVISOR Server was configured successfully the button to configure the server will

vanish.

· Enter the password for the selected HDF-AMD.

Notes:
Programming is not possible without the correct password. The default password is: HDF-Admin
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· Press [Programming HDF-AMD] button in the HDF-CONFIGURATOR software.

· The software indicates the successful programming of the HDF-AMD.

· Wait until the green operating LED illuminates and the yellow control LED is extinguished.

· Switch off the HDF-AMD, close the device housing and install the device in its original position. 

If you changed the configuration in your project (e.g. the number of sensors), the programming described

above needs to be carried out on all HDF-AMD in the project. 

Important notes:
Also program the HDF-AMD to which no changes have been made. This is necessary because the alarm

management systems monitor radio traffic to detect external emissions and interference.

Opening the HDF-AMD housing constitutes an additional security measure to prevent system tampering. The

enclosures should not be left open for convenience or quick access. 

Check all settings after programming has been carried out. Test the programmed HDF-AMD for this.

Possible errors can then immediately be detected.
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Change HDF-AMD password

Passwords should be changed at regular intervals or after irregular events (e.g. the departure of an employee

with knowledge of passwords). 

To change the password of the HDF-AMD, proceed as follows:

· Switch on the HDF-AMD and wait a moment until the green operation LED illuminates.

· Briefly press the control button near the right antenna. The yellow control LED illuminates and the HDF-

AMD is in programming mode (see also "Programming the HDF-AMD").

· The connection to the HDF-AMD is via the wireless network. It is therefore important that your personal

computer is within radio range of the HDF-AMD.

· In the HDF-CONFIGURATOR software, press the "rotating arrow" next to the input field "Select HDF-

AMD".

· The corresponding HDF-AMD is detected and displayed.

· Enter the correct current password. 

Notes:
Changing the password is not possible without the correct current password. 

The default password is: HDF-Admin

· Enter the new password and confirm the password.

· Press [Change Device Password].

· The software indicates that the password has been successfully changed.

· Wait until the green operating LED illuminates and the yellow control LED is extinguished.

· Switch off the HDF-AMD, close the device housing and install the device in its original position. 

Notes:
The password consists of at least 6 characters. Please choose a "strong" password, e.g. consisting of a

random combination of numbers and letters. The selected password is the device password of the HDF-AMD.

It is used for programming the devices. It is not to be confused with the project password and the password of

the alarm centres (HDF-BUZZER and HDF-SPEECH).

Save the password in a secure location. If the password is lost, it can no longer be changed. The device will

then have to be reset to factory settings.
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Read HDF-AMD configuration

The basic steps for reading out the configuration of an HDF-AMD are identical to programming the unit.

Follow these steps for reading out the configuration of a HDF-AMD:

· Open the housing cover of the HDF-AMD.

· Switch on the HDF-AMD and wait a moment until the green operation LED illuminates.

· Briefly press the control button near the right antenna. The yellow control LED illuminates and the HDF-

AMD is in programming mode (see also "Programming the HDF-AMD").

· The connection to the HDF-AMD is via the wireless network. It is therefore important that your personal

computer is within radio range of the HDF-AMD.

· In the HDF-CONFIGURATOR software, press the "rotating arrow" next to the input field "Select HDF-

AMD".

· The corresponding HDF-AMD is detected and displayed.

· Enter the correct current password.

Note:
It is not possible to read the configuration without the correct password. 

· Press the [Read Configuration] button in the HDF-CONFIGURATOR software.

· The software displays the configuration of the HDF-AMD in the centre of the window. You can scroll

through this window to view all entries.

· You can add the configuration to the existing project, if desired. To do so, press the [Add To Project]

button in the HDF-CONFIGURATOR software.

· You will be asked whether the existing project information should be retained or whether the settings in

the project should be overwritten.

Note:
Before rewriting the data, you should backup the current project with [Save as].

· Switch off the HDF-AMD, close the device housing and install the device in its original position. 
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Download HDF-AMD log files

The basic steps for reading out the log files of an HDF-AMD are identical to programming the unit. The log

files can provide interesting conclusions about the operation of the security device.

Note:
Older log files are regularly deleted, since the storage space for log files on an HDF-AMD is limited. It is

recommended to read out and archive the log files at regular intervals.

Follow these steps for reading out the log files of a HDF-AMD:

· Open the housing cover of the HDF-AMD.

· Switch on the HDF-AMD and wait a moment until the green operation LED illuminates.

· Briefly press the control button near the right antenna. The yellow control LED illuminates and the HDF-

AMD is in programming mode (see also "Programming the HDF-AMD").

· The connection to the HDF-AMD is via the wireless network. It is therefore important that your personal

computer is within radio range of the HDF-AMD.

· In the HDF-CONFIGURATOR software, press the "rotating arrow" next to the input field "Select HDF-

AMD".

· The corresponding HDF-AMD is detected and displayed.

· Enter the correct current password.

Note:
It is not possible to read the log files without the correct password. 

· Press [List Logfiles] in the HDF-CONFIGURATOR software.

· The software displays the detected log files in the centre of the window. 

· You can specify a storage location and download the log files individually.

· To view the log files, open these in any editor programme.

· Switch off the HDF-AMD, close the device housing and install the device in its original position. 
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Miscellaneous

Changes to technical specifications and errors are possible. The manufacturer reserves the right to change

the technical specifications of individual devices and components at any time and without providing reasons.

The copyright of this document is owned by heddier electronic GmbH. The production of copies for work

support or maintenance of the Human Detector Flex security systems is permitted at any time. The

production of copies for distribution to third parties, even in excerpts - by whatever means - is only permitted

after written approval. 

Windows is a registered trademark of Microsoft Inc, USA.
Human Detector is a registered trademark of heddier electronic GmbH.
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Help & Support

Despite its simple operation, many users find modern security technology quite complex and can grasp the

concept to some extend only. The diversity of museums and collections requires an expert and the task-

related installation of the Human Detector Flex technology. The aim is to create a security system that is

optimized to customer needs. If you are in charge of the installation, we would like to make the following

suggestions:

Suggestion Thoroughly read the operating instructions to understand the various functions and

special features of the individual components. Compare the delivered systems with the

documentation.

Suggestion It often is beneficial to try out an installation outside the exhibition first. Build small

functional units and put them into operation. Change the settings of the various

components and observe the outcome.

Suggestion Plan your security system in advance. Create a diagram of which sensors collaborate

with which alarm devices. Use your diagram as a guide during the installation. If you

make changes to your concept - which is very likely - enter them immediately in your

diagram. Remember, accurate project documentation is a prerequisite for all

future work on your security system.

Questions Please direct any questions to your retailer first. They should be trained and be able to

answer your questions. If not, they will receive the necessary support from us.

Training Take advantage of our training opportunities. We will train you and your colleagues in

the installation and use of the Human Detector Flex security technology. The training

courses can take place at your premises or at our training centre in Coesfeld (near

Münster in North Rhine-Westphalia, Germany). Training can be combined with the

initial installation of your security system, if required. Our sales department will be

happy to inform you about costs, conditions and dates for technical training.

Support Do you need help quickly? Our technical support can be reached by phone Monday to

Thursday between 8.00 and 17.00 or on Friday until 15.00. Training and technical

support can be provided by email, phone or video conference (Microsoft Teams). 

Technical Support:          heddier electronic GmbH

support@heddier.com

                                         Phone: +49 2864 95 178-0

Important! Check the functions of all installed components at regular intervals. This is

important in order to detect deviations from normal operation and possible errors at an

early stage. Prepare and archive a test protocol. The tests can range from triggering a

test alarm to checking the radio links and battery voltages. We will tell you about the

exact procedure in our training courses.

heddier electronic GmbH reserves the right to make different service agreements with museums,

collections, private collectors and other institutions. These agreements may include special services,

response and repair times. All such agreements shall be in writing and signed. Verbal agreements outside the

scope of the normal use of our systems and support are only valid after written confirmation.


